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Change Log

Date Change Description
2017-07-27 Initial release.
2017-08-11

Minimum CPU cores required for up to 30 devices increased to two.

2017-08-30 Specified that VM licenses are perpetual.
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Introduction

The FortiManager Security Management appliances allow you to centrally manage any number of Fortinet Network
Security devices, from several to thousands, including FortiGate, FortiWiFi, and FortiCarrier. Network administrators
can better control their network by logically grouping devices into administrative domains (ADOMs), efficiently applying
policies and distributing content security/firmware updates. FortiManager is one of several versatile Network Security
Management Products that provide a diversity of deployment types, growth flexibility, advanced customization through
APls and simple licensing.

This document describes how to deploy a FortiManager virtual appliance in several virtualization server environments.
This includes how to configure the virtual hardware settings of the virtual appliance. This guide presumes that the
reader has a thorough understanding of virtualization servers.

This document does not cover configuration and operation of the virtual appliance after it has been successfully
installed and started. For that information, see the FortiManager Administration Guide in the Fortinet Document
Library.

FortiManager documentation

The following FortiManager product documentation is available:

o FortiManager Administration Guide

This document describes how to set up the FortiManager system and use it to manage supported Fortinet units. It
includes information on how to configure multiple Fortinet units, configuring and managing VPN policies,
monitoring managed devices, viewing and analyzing logs, updating virus and attack signatures, providing web
filtering and email filter service to licensed devices as a local FortiGuard Distribution Server (FDS), and firmware
revision control and updating the firmware images of the managed units.

o FortiManager device QuickStart Guides

These documents are included with your FortiManager system package. Use these document to install and begin
working with the FortiManager system and GUI.

« FortiManager Online Help

You can get online help from the FortiManager GUI. FortiManager online help contains detailed procedures for
using the GUI to configure and manage devices.

o FortiManager CLI Reference

This document describes how to use the FortiManager Command Line Interface (CLI) and contains references for
all CLI commands.

o FortiManager Release Notes

This document describes new features and enhancements in the FortiManager system for the release, and lists
resolved and known issues. This document also defines supported platforms and firmware versions.

o FortiManager VM Install Guide
This document, which describes installing FortiManager VM in your virtual environment.
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License and System Requirements

« Licensing
e Minimum system requirements

Licensing

Fortinet offers the FortiManager VM in a stackable license model. This model allows you to expand your VM solution as
your environment expands. Virtual appliance licenses are also perpetual - they never expire.

For information on purchasing a FortiManager VM license, contact your Fortinet Authorized Reseller, or visit
http://www.fortinet.com/how_to_buy/.

When configuring your FortiManager VM, ensure to configure hardware settings as outlined in the following table and
consider future expansion. Contact your Fortinet Authorized Reseller for more information.

Licensed Network Devices Administrative Domains
VM-BASE 10 10
VM-10-UG +10 +10
VM-100-UG +100 +100
VM-1000-UG +1000 +1000
VM-5000-UG +5000 +5000
VM-10K-UG +10000 +10000

For more information, see Minimum system requirements on page 8, and the FortiManager product data sheet:
http://www.fortinet.com/sites/default/files/productdatasheets/FortiManager-VM. pdf

After placing an order for FortiManager VM, a license registration code is sent to the email address used in the order
form. Use the license registration code provided to register the FortiManager VM with Customer Service & Support at
https://support.fortinet.com.

Upon registration, you can download the license file. You will need this file to activate your FortiManager VM. You can
configure basic network settings from the CLI to complete the deployment. Once the license file is uploaded and
validated, the CLI and GUI will be fully functional.

Evaluation license

FortiManager VM includes a free, full featured 15 day trial license. No activation is required for the built-in evaluation
license.

FortiManager VM Install Guide Fortinet Technologies Inc.


http://www.fortinet.com/how_to_buy/
http://www.fortinet.com/sites/default/files/productdatasheets/FortiManager-VM.pdf
https://support.fortinet.com/

License and System Requirements

The trial period begins the first time you start the FortiManager VM. When the trial expires, all functionality is disabled

until you upload a license file.

Technical support is not included with the 15-day evaluation.

Al
b [ 4
q Contact your Fortinet Reseller to request a full evaluation (60-days) license.

Minimum system requirements

The following table lists the minimum system requirements for your VM hardware, based on the number of devices,

VDOMs, or ADOMs that your VM manages.
VM Hardware Requirements

Maximum Devices / VDOMs

RAM (GB) CPU cores
100 8 2
300 16 6
1200 32 6
4000 64 16
10000 128 24
Ay
‘9' This table does not take into account other hardware specifications, such as bus speed, CPU
|| model, or storage type.
Ay
S L4
9 Enabling FortiAnalyzer features will require more resources.
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Registration and Deployment

« Register with Customer Service & Support
« Deployment package
« Deploying the appliance

Register with Customer Service & Support

To obtain the FortiManager VM license file you must first register your FortiManager VM with Fortinet Customer
Service & Support.

To register your FortiManager VM:

1. Login to the Fortinet Customer Service & Support portal using an existing support account or click Create an
Account to create a new account.

2. Inthetoolbar select Asset > Register/Renew. The Registration Wizard opens.

3. Enter the registration code from the FortiManager VM License Certificate that was emailed to you, select the end
user type, and then click Next. The Registration Info page is displayed.

License
Registration

€\ da  Registering FortiManager-VM

Registration Code > [EM Registrationinfo > | 3 Agreement > |4 Verification > |5 Completion

Specify Fortinet Registration Information
If you have purchased a support contract for this product, you may register it now or later.

Support Contract No.:

To help you identify this product, you may enter a description here

Product Description: | FortiManager VM

Please specify your Fortinet Part Reseller helped you with thi

Fortinet Partner:* | Web Wireless Inc. v

IP Address: = 172.12.44.36

4. Enter your support contract number, product description, Fortinet Partner, and IP address in the requisite fields,
then select Next.

As a part of the license validation process FortiManager VM compares its IP address with
the IP information in the license file. If a new license has been imported or the
FortiManager VM’s IP address has been changed, the FortiManager VM must be
rebooted in order for the system to validate the change and operate with a valid license.

FortiManager VM license validation. You must specify an IPv4 address in both the
support portal and the port management interface.

.2 The Customer Service & Support portal currently does not support IPv6 for
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Registration and Deployment 10

5. Onthe Fortinet Product Registration Agreement page, select the checkbox to indicate that you have read,
understood, and accepted the service contract, then select Next to continue to the Verification page.

6. The verification page displays the product entitlement. Select the checkbox to indicate that you accept the terms
then select Confirm to submit the request.

License i
g FortiManager-VM

Registration

Registration Code > Registration Info > Agreement > Verification > H Completion

Registration Completed

Thank you for choosing Fortinet product. Your registration process has successfully completed. Please be aware that the registration information may not reflect on your product immediately, a
delay (up to 4 hours) can occur.
Product Info

General

Product Model: FortiManager-VM
serial Number: FMG-VMOA13000079
License Number: FMVMO0005274
Supported Devices: 10
Supported FortiClients: 2500
Registration Date: 2014-02-07
Description: FortiManager VM
Partner: WebTech Wireless Inc.
IP Address: 172.12.44.36
License File: License File Download

Support Coverage

No service coverage!

Registered License(s)
License Type License Number Key Registration Date
FortiManagervm FMVM0005274 N/A 2014-02-07

FortiManage VM base license for 10 devices/domains. 1 GB/Day log and 100 GB device quota.

7. From the Registration Completed page you can download the FortiManager VM license file, select Register More
to register another FortiManager VM, or select Finish to complete the registration process.

Select License File Download to save the license file (.11 c) to your management computer. See Upload the
license file on page 49 for instructions on uploading the license file to your FortiManager VM via the GUI.

To edit the FortiManager VM IP address:

1. Inthe toolbar select Asset > Manage/View Products to open the View Products page.
2. Select the FortiManager VM serial number to open the Product Details page.

3. Select Edit to change the description, partner information, and IP address of your FortiManager VM from the Edit
Product Info page.
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Registration and Deployment 11

Product FortiManager-VM

Details FMG-VMOAT 300

© Back To List

Information Edit Product Info
n

@ Location

Description:

FortiManager VM
2 Entitlement

W License

Partner Info:
WebTech Wireless Inc.
Registration
B} Renew Contract

IP Address:

172.12.44.36
=+ Add Licenses You can update IP address for 5 time(s).

© FNDN Trial
Assistance
iS Ticket List
& Technical Request
Customer Service
DOA Request
=2 RMA Request

& WebChat

4. Enterthe new IP address then select Save.

You can change the IP address five (5) times on a regular FortiManager VM license.
There is no restriction on a full evaluation license.

5. Select License File Download to save the license file (.11 c) to your management computer. See Upload the
license file on page 49 for instructions on uploading the license file to your FortiManager VM via the GUI.

Deployment package

FortiManager VM deployment packages are included with firmware images on the Customer Service & Support site.
The following table list the available VM deployment packages.

VM Platform Deployment File

Amazon Web Service AMI, EC2, and EBS The 64bit Amazon Machine Image (AMI) is available in the AWS
marketplace.

Microsoft Azure The Microsoft Azure based VM is available in the Azure portal.

Citrix XenServer 6.2 FMG VM64 XEN-v5-buildxxxx-
FORTINET.out.CitrixXen.zip

Linux KVM RedHat 6.5 FMG VM64 KVM-v5-buildxxxx-FORTINET.out.kvm.zip
Microsoft Hyper-V Server 2008 R2 and 2012  FMG_VM64 HV-v5-buildxxxx-FORTINET.out.hyperv.zip

Open Source XenServer 4.2.5 FMG VM64 XEN-v5-buildxxxx-
FORTINET.out.OpenXen.zip

VMware ESX 4.0 and 4.1 ESX/ESXi server:
VMware ESXi 4.0, 4.1, 5.0, 5.1, 5.5, and 6.0 FMG VM64-v5-buildxxxx-FORTINET.out.ovf.zip

For more information see the FortiManager VM datasheet available on the Fortinet web site:
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https://www.fortinet.com/products/management/fortimanager.html.

Firmware image FTP directories are organized by firmware version, major release, and patch release. The firmware
images in the directories follow a specific naming convention and each firmware image is specific to the device model.
Forexample, the FMG_VM64 HV-v5-buildxxxx-FORTINET.out.hyperv.zipimage, foundinthe 5.4.0
directory, is specific to the 64bit Microsoft Hyper-V Server virtualization environment.

L}
‘?' You can download the FortiManager Release Notes and MIB file from this directory. The
Fortinet Core MIB file is located in the main FortiManager 5.00 directory.

I\ Download the . out file to upgrade your existing FortiManager VM installation.

To download the firmware package:

1. Login to the Fortinet Customer Service & Support portal then, from the toolbar select Download > Firmware
Images. The Firmware Images page opens.

Select FortiManager from the Select Product drop-down list, then select Download.

Browse to the appropriate directory for the version that you would like to download.
Download the appropriate firmware image and release notes to your management computer.
Extract the contents of the package to a new folder on you management computer.

o~ owbd

Deployment package contents

Citrix XenServer

The .out.CitrixXen. zip file contains:

« fmg.xva: The Citrix XenServer Virtual Appliance (XVA) binary file containing virtual hardware configuration
settings.

« ovf folder:

e« FortiManager.ovf: Open Virtualization Format (OVF) template file, containing virtual hardware settings
for Xen.

o fmg.vhd: The FortiManager VM system hard disk in VHD format.
o datadrive.vhd: The FortiManager VM log disk in VHD format.

Linux KVM

The .out.kvm. zip file contains:

« fmg.gcow2: TheFortiManager VM system hard disk in QCOW2 format.
The log disk and virtual hardware settings have to be configured manually.

Microsoft Hyper-V

The .out.hyperv. zip file contains:
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e fmg.vhd: The FortiManager VM system hard disk in VHD format.
The log disk and virtual hardware settings have to be configured manually.

Open Source XenServer

The .out.OpenXen. zip file contains:

o fmg.gcow?2: The FortiManager VM system hard disk in QCOW?2 format.
The log disk and virtual hardware settings have to be configured manually.

VMware

The .out.ovf.zip file contains:

« fmg.vmdk: The FortiManager VM system hard disk in Virtual Machine Disk (VMDK) format.
e« FortiManager-VM64.ovf: The VMware virtual hardware configuration file.
o« DATADRIVE.vmdk: The FortiManager VM log disk in VMDK format

Deploying the appliance

Prior to deploying the FortiManager VM, the VM platform must be installed and configured so that it is ready to create
virtual machines. The installation instructions for FortiManager VM presume that you are familiar with the management
software and terminology of your VM platform.

For assistance in deploying FortiManager VM, refer to the deployment chapter in this guide that corresponds to your
hypervisor environment. You may also need to refer to the documentation provided with your VM server. The
deployment chapters are presented as examples because, for any particular VM server, there are multiple ways of
creating a virtual machine - command line tools, APIs, alternative graphical user interface tools.

Before you start your FortiManager VM appliance for the first time, you might need to adjust virtual disk sizes and
networking settings. With the exception of AWS and Azure environments, the first time you start FortiManager VM, you
will have access only through the console window of your VM server environment. After you configure one network
interface with an IP address and administrative access, you can access the FortiManager GUI (see GUI access on page
47).
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Citrix XenServer deployment example

Once you have downloaded the FMG VM64 XEN-v5-buildxxxx-FORTINET.out.CitrixXen.zip file and
extracted the files, you can create the virtual machine in your Citrix Xen environment.

The following topics are included in this section:

o Create the virtual machine
« Configure hardware settings
« Start the virtual machine

Create the virtual machine

To create the virtual machine:

1. Launch XenCenter on your management computer.
The management computer can be any computer that can run Citrix XenServer, a Microsoft Windows application.
2. Click ADD a server, then enter the Citrix XenServer |P address and the root logon credentials required to manage
that server.
Your Citrix XenServer is added to the list in the left pane, and the Virtual Machine Manager home page opens.
Select File > Import.
Click Browse, locate the fmg . xva file, select Open, then select Next.
Choose the pool or standalone server that will host the VM, then click Next.
Select the storage location for the FortiManager VM disk drives, then click Next.
Configure the virtual network interfaces, then click Next. By default, there are four virtual network interfaces.
(] Import XVA - oIEN

@L Select network to connect VM 2]

No o~

Import Source The default virtual network interfaces for the template you have selected are listed below. You can add,

Home Server modify or delete virtual network interfaces, if required.

Storage When you have finished, click "Nedt" to continue to the next page.

TR i neoverk interfaces instaled on the new vinual machines:

Finish Name MAC Address Network
interface 0 desldilae2:8b:91 Network 0
interface 1 2a:1fd 27:86 Network 1 -
interface 2 06:a3:ac:68:fb:80 Network 2 -
ety et N B
- . Add Delet:
ciTRIX
Next > C |

8. Review the import settings, deselect Start VM(s) afterimport, and then click Finish to import the VM.

The Citrix XenServer imports the FortiManager VM files and configures the VM as specified in the template.
Depending on your computer's hardware speed and resource load, as well as on the file size and speed of the
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Citrix XenServer deployment example 15

network connection, this may take several minutes to complete
When the VM import is complete, the XenServer left pane will include the FortiManager VM in the list of deployed
VMs for your Citrix XenServer.

Configure hardware settings

Before starting your FortiManager VM for the first time, you must adjust the VM's virtual hardware settings to meet your
network requirements.

To access VM settings, open XenCenter and select the FortiManager VM in the left pane. The tabs in the right pane
provide access to the virtual hardware configuration, and the console tab provides access to the FortiManager console.

Disk resizing must be done before you start the VM for the first time.
ﬂ If you know your environment will expand in the future, it is recommended to add hard disks
I larger than the 500GB base license requirement. This will allow your environment to be
expanded as required while not taking up more space than is needed.

To set the number of CPUs:

1. Inthe XenCenter left pane, right-click the FortiManager VM and select Properties.
2. Inthe left pane of the Properties window, select CPU.

[x] ‘FortiManager-VM64-Xen (1)’ Properties ?
Gy
FMG-VME4-Xen
= Custom Fields The number of VCPUs available to your VM can be adjusted, as well as the priority to 25sign to them over other
<None> VCPUs.
- CPU
T AVCPUL) Number of VCPUs: 4
@ Boot Options . )
None defined VCPU priority for this virtual machine:
[ Start Options . . . . . . . .
HA is not available on stan... Lowest Nermal Highest
L Aets
None defined
[ Hom
xens

3. Adjust the in the Number of VCPUSs, then click OK.
XenCenter will display a warning if you select more CPUs than the Xen host computer contains. Such a
configuration might reduce performance.

To set the memory size:

1. Inthe XenCenter left pane, select the FortiManager VM.
2. Intheright pane, select the Memory tab.
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Citrix XenServer deployment example 16

3. Click Edit and modify the value in the Set a fixed memory of field. See Minimum system requirements on page 8
to determine your required memory.

4. Click OK.

(<] Memory Settings ?

Set a fixed memory for this VM, or set a memory range and allow the VM's memory allocation to
be adjusted automatically.

(®) Set a fixed memory of 8192 % MB

£ Amemory range cannot be set because XenServer Tools are not installed on this VM.
Install XenServer Tools now

Cancel

To resize the data disk:

1. Inthe XenCenter left pane, select the FortiManager VM.
2. Intheright pane, select the Storage tab.
3. Select the data disk, then click Properties to open the Properties window.
4. Select Size and Location.
b ‘datadisk’ Properties 2
General = Size and Location

datadisk
= CustomFields You can increase the size of your disk so more space is available for your VM. Reducing the size of your disk is not
<None> supported
Size and Location
80 68, Local storage on xen...
FortiManager-VME4-Xen (1)

Device 1, (Read / Write)

Size: 80.000)2]| GB

Location: ‘Local storage’

5. Adjust the Size to the required value, then click OK.

The FortiManager VM allows for 12 virtual log disks to be added to a deployed instance.

\ﬂ When adding additional hard disks use the following CLI command to extend the LVM logical

volume:

execute lvm start
execute lvm extend <arg ..>
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Citrix XenServer deployment example 17

Start the virtual machine

You can now proceed to start on your FortiManager VM.

« Inthe XenCenter left pane, right-click on the name of the FortiManager VM and select Start.
« Select the name of the FortiManager VM from the left pane, then select Start in the toolbar.

Once the VM has started, proceed with the initial configuration. See Initial Configuration on page 47.
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Hyper-V deployment example

Once you have downloaded the FMG VM64 HV-v5-buildxxxx-FORTINET.out.hyperv. zip file and extracted
the package contents to a folder on your Microsoft server, you can deploy the VHD package to your Mircosoft Hyper-V
environment.

The following topics are included in this section:

o Create the virtual machine
« Configure hardware settings
o Start the virtual machine

Create the virtual machine

To create the virtual machine:

1. Launch the Hyper-V Manager in your Microsoft server. The Hyper-V Manager home page opens.

2. Select the server in the right-tree menu. The server details page opens.
EE| Hyper-V Manager == -

File Action View Help

= z[m B]=

53 Hyper-¥ Manager H Actions
;3 ! I‘ New 2 Vintual Machine.. |I Usage Assigned Memot Uptime Status. L3 WINGOT2 =
Tmport Virtual Machine... Hard Disk. g mnga =7 3597 s New » |
Hyper-V Settings. Floppy Disk. 2048 1B 074816 [ Import Virtual Machine...
Virtual Switch Manager... Ho4bit-23 Running 1% 2048 MB 28034744 2 Hyper-V Settings...
Virtual SAN Manager... | Off 1 Virtual Switch Manager.
A T S S .
LERebE S Rurning 0% 1024 MB 105:37:12 ¢ Edit Disk...
Stop Service phine Off (& Inspect Disk.
TS Running 0% 1024 MB 39192730 | | @ stop senvice
Refresh [0 > X Remove Server
View 4 @ | | Refresh
Help . ser VM HV - (10/22/2013 - £:30:08 FM) View 4
E-Z Foribanager VM HV - (10/22/2013 - 43021 PM) H e
B Now
FortiManager VM HV S
= Connect..
24 Settings.,
(@ Turn Off..
@ Sshut Down...
© Save
Il Peuse
FortiManager VM HV 1> Reset
S Snapshot
Created: 10/22/2013 34220 PM Clustered: No 9 Revet..
- Notes:  None Heartbeat: OK (No Appiication Daz) P Move.
=[ Rename..
47 Enable Replication
Summary | Memory | Networking | Replcation B Hep

Displays the New Virtual Machine Wizard.

3. Right-click the server and select New > Virtual Machine, or in the Actions menu, select New > Virtual Machine.
The New Virtual Machine Wizard opens.
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Hyper-V deployment example 19

4. Click Next to create a virtual machine with a custom configuration. The Specify Name and Location page opens.

~ New Virtual Machine Wizard -
[’ &\‘ Specify Name and Location

=N

Before You Begn Choase a name and lacation for this virtual machine.

Enicek i mera b mal The name is displayed in Hyper-V Manager. We recommend that you use a name that helps you easily

Assign Memory identify this virtual machine, such as the name of the guest operating system or workload

Configure Networking Name: [FortManager Vi-HY|

e sl e You can create a folder o use an existing folder to store the virtual machine. If you don't selecta
Installation Options folder, the virtual machine is stored in the default folder configured for this server.
Summary [ Store the virtual machine in a different location

C:\ProgramData Microsoft\Windows\Hyper-

[rrewom | (o | oo | [ ]

5. Enter a name for this VM. The name is displayed in the Hyper-V Manager.
6. Click Next to continue to the Assign Memory page .

7. Specify the amount of memory to allocate to this virtual machine. See Minimum system requirements on page 8 to
determine your required memory.

8. Click Next to continue to the Configure Networking page.
9. You must configure network adapters in the Settings page.

Each new VM includes a network adapter. You can configure the network adapter to use a virtual switch, or it can
remain disconnected. FortiManager VM requires four network adapters.

10. Select Next to continue to the Connect Virtual Hard Disk page.

w New Virtual Machine Wizard ||
| .
i | Connect Virtual Hard Disk
s
Before You Begin A virtual machine requires storage so that you can install an operating system. You can specify the

N storage now or configure it later by modifying the virtual machine's properties.

Assign Memory (O Create 3 virtual hard disk

- Use this option to create a dynamically expanding virtual hard disk with the default format (VHDX).

Connect Virtual Hard Disk FartiManager YM-HY.vhdx

Summary Ca\Users'Public Documents\Hyper-V\Wirtual Hard Disks

127| 6B (Maximum: 64 TB)

® Use an existing virtual hard disk
Use this option to attach an existing virtual hard disk, either VHD or VHDX format.

Location: [£:\Lsers\Administrator \Desktop FMG-H\fmg.vhd [ Bromse.

O Attach a virtual herd disk later
Use this option to skip ths step now and attach an existing virtual hard disk leter.

[(<prevous | [ newt> | [ Fen | [ cancel |

11. Select to use an existing virtual hard disk and browse for the fmg . vhd file that you downloaded from the Fortinet
Customer Service & Support portal.

12. Select Next to continue to the Summary page.
13. To create the virtual machine and close the wizard, select Finish.

Configure hardware settings

Before powering on your FortiManager VM you must configure the virtual processors, memory, network adapters, and
hard disk to match your FortiManager VM license. See Licensing on page 7 for FortiManager VM license information.
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Hyper-V deployment example

To open the Settings page, in the Hyper-V Manager, right-click on the name of the virtual machine and select Settings,
or select the virtual machine then click Settings from the Actions menu.

£ Settings for FortiManager VM-HV on WIN2012 | = [o [
‘+a
A :{ardware o | ¥ AddHardware

- Add Hardware

You can use this seting to add devices to your virtual machine.
Select the devices you want to 2dd and cick the Add button.

3 Processor ik
1 Virtual processor Fibre Channel Adapter
= B IDE Controller 0 RemateF} 30 Video Adapter
a Hard Drive
= [BE IDE Controller 1
{4 DVD Drive A network adapter requires drivers that are installed when you instal integration
e servicesin the guest operating system.

83 5CSI Controller
§ Network Adapter

¥ oMt
7 com2
[ Diskette brive

A Management
[T

[ Integration Services

mart Paging Fie Location

To configure virtual memory:

1. Inthe Settings page, select Memory from the Hardware menu. The Memory page is displayed.

Configure the memory for the VM. See Minimum system requirements on page 8 to determine your required
memory.

3. Click Apply to save your settings.

To configure virtual processors:

1. Inthe Settings page, select Processorfrom the Hardware menu. The Processor page is displayed.

2 Processor

You can modify the number of virtual processors based on the number of processars on
the physical computer. You can also modify other resource contral settings

MNumber of virtual processors: S

Resource control

You can use resource controls to balance resources among virtual machines.

e s et e (peneeer e | 9
Percent of total system resources: 0
Virtual machine fimit (percentage):
Percent of total system resources: 75

Relative weight:

2. Configure the number of virtual processors for the VM. Optionally, you can use resource controls to balance
resources among VMs.

3. Click Apply to save your settings.
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To configure network adapters:

1. Inthe Settings page, select Add Hardware from the Hardware menu.
2. From the device list, select Network Adapter, then click Add. The Network Adapter page opens.

0 Network Adapter

Specify the of the network adapter or remove the network adapter.
Virtual switch:
[Broadcom Netxtreme Ggabit Ethernet - Virtual Switch -

VLANTD
[] Enable virtual LAN identification

Bandwidth Management
[] Enable bandnidth management

o

To remove the network adapter from this virtual machine, dick Remove.

@ legacy network adapter instead of this network adapter to perform a
network-based installation of the quest operating system or when integration
not installed in the guest operating system.

3. Manually configure four network adapters in the settings page. For each network adapter, select a virtual switch
from the drop-down list.

4. Click Apply to save your settings.

To configure the virtual hard disk:

FortiManager VM, you must add at least one more virtual hard disk. The default hard drive,

s‘é’, The FortiManager VM requires at least two virtual hard disks. Before powering on the
- fmg . vhd, contains the operating system. The second hard drive is used for logs.

\, If you know your environment will expand in the future, it is recommended to add hard disks
‘?' larger than the 500GB base license requirement. This will allow your environment to be
expanded as required while not taking up more space in the Storage Area Network (SAN)

than is needed.

The FortiManager VM allows for 12 virtual log disks to be added to a deployed instance.

\ﬂ When adding additional hard disks use the following CLI command to extend the LVM logical

volume:

execute lvm start
execute lvm extend <arg ..>
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1. Inthe Settings page, select IDE Controller 0 from the Hardware menu.

2. Select the type of drive that you want to attach to the controller, then click Add. The Hard Drive page opens.

@ Hard Drive

You can change how this virtual hard disk is attached to the virtual machine, 1f an
operating system is installed on this disk, changing the attachment might prevent the
virtual machine from starting.

Controler: Location:
[10E Contraler o v] [0 tnuse)

Media

You can compact or convert a virtual hard disk by editing the associated file.
Specify the full path to the fie.

@ Virtual hard disk:

[cisers\administrator Deskiop \FMG Y fing.vhd |

e | [ea ] [ | [orome ]

@ 1 the physical hard disk you want to use is not listed, make sure that the
disk is offiine. Use Disk Management on the physical computer to manage
physical hard disks.

To remove the virtual hard disk, ciick Remove. This disconnects the disk but does not

delete the associated file

Click New to create a new virtual hard disk. The New Virtual Hard Disk Wizard opens to help you create a new
virtual hard disk.

4. Click Next to continue to the Choose Disk Format page.

Select to use VHDX format virtual hard disks. This format supports virtual disks up to 64TB and is resilient to

consistency issues that might occur from power failures. This format is not supported in operating systems earlier
that Windows Server 2012.

6. Click Next to continue to the Choose Disk Type page.

=) New Virtual Hard Disk Wizard -

— Choose Disk Type

Before You Begin What type of virtual hard disk do you want to create?

(Choose Disk Format:
Choose Disk Type Thi type of disk provides better performance and i recommended for servers running applcations

Specify Name and Locati with hich leves of dik ackvity. The virtul hard disk fi that s ceated nitilly uses the size of the
FETLERET R virtual hard disk and does not change when data i deleted or sdded.

() Fixed size

Conffigure Disk .

® Dynamically expanding

=y This type of disk provides better use of physical storage space and is recommended for servers.
running appiications that are not disk intensive, The virual hard disk fil thatis created is small
initially and changes as data is added

O Differenang
This type of disk is assoiated in 2 parent-chid relationship with another disk that you want to
leave intact. You can make changes to the data or operating system without affecting the parent

disk, 50 that you can revert the changes easiy. All children must have the same virtual hard disk
format as the parent (VHD or VHDX).

[<previos | [ mext> | [ Fmsh | [ concel |

7. Select the type of virtual disk you want to use, one of the following:

« Fixed Size: This type of disk provides better performance and is recommended for servers running
applications with high levels of disk activity. The virtual hard disk file that is created initially uses the size of
the virtual hard disk and does not change when data is deleted or added.

o Dynamically Expanding: This type of disk provides better use of physical storage space and is recommended
for servers running applications that are not disk intensive. The virtual disk file that is created is small initially
and changes as data is added.

Differencing: This type of disk is associated in a parent-child relationship with another disk that you want to
leave intact. You can make changes to the data or operating system without affecting the parent disk, so that
you can revert the changes easily. All children must have the same virtual hard disk format as the parent (VHD
or VHDX).

8. Click Next to continue to the Specify Name and Location page.

9. Specify the name and location of the virtual hard disk file. Use the Browse button to select a specific file folder on
your server.
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10. Click Next to continue to the Configure Disk page.

= New Virtual Hard Disk Wizard -

y Configure Disk

Before You Begn You can create 2 biank virtual hard disk or copy the cantents of an existing physical isk.

TR ® Create a new blank virtual hard disk

CReE R ne Size GB (Maximum: 64TE)

Speay Name and Location

- O Copy the contents of the specified physical disk:
p— Physical Hard Disk Size
v W\ \PHYSICALDRIVED 186368

| PHYSICALDRIVE1 125M8
W\ \PHYSICALDRIVE2 125M8
| PHYSICALDRIVES 1258
"\ \PHYSICALDRIVE4 125M8

O Copy the contents of the specified virtual hard disk

[rrewom | (o | oo | [ ]

11. Select Create a new blank virtual hard disk, then enter the size of the disk in GB. The maximum size is dependent
on your server environment.

12. Click Next to continue to the Summary page.
The summary page provides details about the virtual hard disk.

13. Click Finish to create the virtual hard disk, then click Apply to save the settings, and then click OK to exit the
settings page.

Start the virtual machine

You can now proceed to power on your FortiManager VM.

1. Inthe list of virtual machines, right-click on the name of the FortiManager VM and select Start.

2. Select the name of the FortiManager VM from the list of virtual machines, then click Start from the Actions menu.
EEl Hyper-V Manager - o=

File Action View Help
@ zE BE

23 Hyper-Y Manager

Actions
5a wIN2012 Virtual Machines
& WIN2012 -
Name - State CPU Usage Assigned Memory  Uptime Status A New »
3 b202174723 Off
3 523183 seven Funring 0% 2048 MB 39.09.26:49 [ Import Virtual Machine.
2 b232232 Running 0% 2048 MB 109:41:16 1" Hyper-V Settings.
3 fmgAthurb21564023  Funning 1% 2043 M8 28054044 1 Virtual Switch Manager.
fmgh-b200-20 Off
g fnghv _| |l virtual SAN Manager.
3 ForiGaie VME4HY Runring 0% 1024 MB 29.07.3444 = [=
3 Rvmb24denc Connect... 1024 MB 1.07:30:12 (£l Inspect Disk...
& New Vitusl M Settings... (@) Stop Service
5 m 1024 MB 3921:20:30 -
| Start \ ~1 | %K RemoveServer
Snapshots Blt=ty @) | |G Refresh
Revert... View >
Move. J H Hep
Export.
R FortiManager VM HV -~
ename...
5 Connect..
Delete. ?3 onnec
Enable Replication.. 1 Settings
Help @ sun |
5 Snapshot
) Revert.
= Move..
FortiManager VM HV &/ Export..
=] Rename..
Created: 10/22/2013 3:42.20 FM Clustered: No 5 Delete..
Notes:  None 17 Enable Replication..
H Hep
Summary | Memory | Networking | Replication

Starts the selected virtual machine.

Once the VM has started, proceed with the initial configuration. See Initial Configuration on page 47.
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Once you have downloaded the FMG _VM64 KVM-v5-buildxxxx-FORTINET.out.kvm. zip file and extracted

the virtual hard drive image file, you can create the virtual machine in your KVM environment.

The following topics are included in this section:

o Create the virtual machine
« Configure hardware settings
« Start the virtual machine

Create the virtual machine

To create the virtual machine:

1. Launch Virtual Machine Manager (vit-manager) on you KVM host server. The Virtual Machine Manager home

page opens.

= Virtual Machine Manager
File Edit View Help

L]

Name

= localhost (QEMU)

FMG-KVM-DOC
Shutaff

fgt-b544-103
Running

fgt-b925
Running

fmgkvm-b4063
Running

fmgkvm-b705-116
Running

-

localhost ixen) - Not Connected

v | CPU usage

2. Select Create a new virtual machine from the toolbar.

= New VM
m Create a new virtual machine
——

Enter your virtual machine details

Name: [FMG-K\/M-Doq
Connection: localhost (QEMU/KVM)

Choose how you would like to install the operating system
O Local install media (ISO image or COROM)
© Network |nstall (HTTP, FTP, or NFS)
O Network Boot (PXE)
@ Import existing disk image

| Cancel ‘ | Forward \

3. Entera name for the virtual machine, such as FMG-KVM-DOC.
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4. Ensure that Connection is localhost, select Import existing disk image, then click Forward to continue.

New VM

m Create a new virtual machine

Provide the existing storage path:
l\ ] ‘B[owse...
Choose an operating system type and version
OS type: ‘ Linux < ‘
Version: ‘ Generic 2.6.x kemnel < ‘
| Cancel ‘ | Back ‘ | Forward ‘

5. Inthe OS Type field select Linux.
6. Inthe Version field select Generic 2.6.x kemel. You may have to first select Show all OS options.

7. Click Browse to locate the storage volume.

Locate or create storage volume

Storage Pools

S5 fiesyater Directory
519 az-50gb

Filesystem Directory
o, faz-hdl

Filesystem Directory

go, laz-images
Filesystem Directory

gu, fMagvm-images
Filesystem Directory

{ﬁmwse Local

Name

faz-50gb

faz-hdl
FAZ-OpenXen.img
faz-vd6.img
FAZVM1-1l.img
FAZVML.img
FAZ-xenl.img
fgt-b544-103.img
fmgvm-test.img

v | Size Format
0.00 MB dir
0.00 MB dir

8.00 GB gqcow2
1000.00 MB gcow?2
8.00 GB qeow2
8.00 GB gcow2
1000.00 MB gcow2
8.00 GB qeow2
8.00 GB gcow2

a

| New Volumel

|gan[e!‘

8. If you copied the fmg.qcow2fileto /var/lib/libvirt/images it will be shown on the right. If you saved it
elsewhere on the server, click Browse Local to find it.

9. Once the file has been located, click Choose Volume, then click Forward.

New VM

m Create a new virtual machine

Choose Memory and CPU settings

Memory (RAM): | 8192[2] MB

Up to 15903 MB available on the host

ceus: | 2/

Up to 12 available

‘ Cancel ‘ | Back | [ Forward l

10. Specify the amount of memory and the number of CPUs to allocated to this VM, then select Forward. See

Minimum system requirements on page 8 to determine your required memory.

11. Expand the Advanced options section. By default, a new virtual machine includes one network adapter. Select a

network adapter on the host computer.
Optionally, set a specific MAC address for the virtual network interface.
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12. Set Virt Type to virtio and set Architecture to gcow?2.
13. Click Finishto create the VM.

Configure hardware settings

Before powering on your FortiManager VM you must configure virtual disks and at least four network interfaces.

To configure settings on the server:

In the Virtual Machine Manager, locate the name of the VM, then select Open from toolbar.
In the Virtual Machine window, select Show virtual hardware details.

Click Add Hardware to open the Add Hardware window

Select Storage.

= Add New Virtual Hardware x

e e Storage
Network

Input Please indicate how you would like to assign space
on the host system for your virtual storage device.

o bd-=

[ Graphics
Eﬁ} Sound @ Create a disk image on the computer's hard drive
=4 Serial 80.0 2| GB

A Forallel 23.1 Gb available in the default location

4 Channel
fﬁl USB Host Device
C;E} PCl Host Device

[ Allocate entire disk now )

O Select managed or other existing storage

@ Video

ﬁf Watchdog

] Devicetype:  |[J) Virtio Disk 2. |

£= Smartcard

= Cache mode: | default <
Storage format: ‘raw .

Cancel | Einish

5. Select Create a disk image on the computer's harddrive, and set the size to 80GB.

N - /, If you know your environment will expand in the future, or if you will be using ADOMs, it is
q recommended to add hard disks larger than 500GB. This will allow your environment to
- be expanded as required while not taking up more space than is needed.

The FortiManager VM allows for 12 virtual log disks to be added to a deployed instance.
\ﬂ When adding additional hard disks use the following CLI command to extend the LVM

I logical volume:

execute lvm start
execute lvm extend <arg ..>

6. Enter the following information:

Device Type Virtio disk
Cache mode writethrough
Storage format raw
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7. Select Network to add more network interfaces. The Device Model must be Virtio.

x Add New Virtual Hardware

. Storage

: Input Please indicate how you'd like to connect your
B Graphics new virtual network device to the host network.
Eif sound Host device: | virtual network 'default’ : NAT &

MAC address: [

Device model: | virtio =

=4 Parallel

=4 Channel

C’&E} USB Host Device
E;s PCl Host Device
B video

m} Watchdog

|

&= Smartcard

SR eterk |

1 Cancel |\ Finish

x
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A new VM includes one network adapter by default. More can be added through the Add Hardware window.
FortiManager VM supports up to four network adapters. You can configure network adapters to connect to a virtual
switch or to network adapters on the host computer.

8. Click Finish.

Start the virtual machine

You can now proceed to power on your FortiManager VM.

1. Right-click on the FortiManager VM and select Run, or
2. Select the FortiManager VM from the list of VMs, then click Power on the virtual machine from the toolbar.

= Virtual Machine Manager
File Edit View Help

[Es | (== Open Dk

Name Power on the virtual machine

~ localhost (QEMU)

fgt-b544.103
Running

fgt-b925
Running Clone...

Running Delete

fmgkvm-b705-116
Running

Open

=
=
EJ fmgkvm-b4063
EJ

localhost ixen) - Not Connected

v | CPU usage

=]

x

Once the VM has started, proceed with the initial configuration. See Initial Configuration on page 47.

FortiManager VM Install Guide

Fortinet Technologies Inc.



Open Xen deployment example

Once you have downloaded the FMG VM64 XEN-v5-buildxxxx-FORTINET.out.OpenXen.zip file and
extracted the fmg.qcow?2, you can create the virtual machine in your Open Xen environment.

Create and configure the virtual machine

To deploy and configure the virtual machine:

1. Launch Virtual Machine Manager (virt-manager) on you Open Xen host server. The Virtual Machine Manager
home page opens.

2. Select Create a new virtual machine from the toolbar.

New VM 0 x

m Create a new virtual machine

Enter your virtual machine details

Name: |
Connection: localhost (xen)

Choose how you would like to install the operating system
O Local install media (ISO image or COROM)
O Network Install (HTTP, FTP, or NFS)
O Network Boot (PXE)
©[mport existing disk image]

¢ cancel | s Back | i,;fnrwardl

Enter a name for the VM, such as FMG-VM.

Ensure that Connection is localhost, select Import existing disk image, then click Forward to continue.
In the OS Type field select Linux. In the Version field select Generic 2.6.x kernel.

Click Browse to open the Locate or create storage volume window.

No o s~

Click Browse Local, find the fmg.qcow2 disk image file, then click Choose Volume and then Forward.

- New VM +0Xx
m Create a new virtual machine

Choose Memory and CPU settings
Memory (RAM): |8192}7| MB

Up to 8192 MB available on the host

ceus: [ 4

Up to 8 available

& cancel | <= Back | ’#,,Eurwardl

8. Specify the amount of memory and the number of CPUs to allocated to this VM. See Minimum system
requirements on page 8 to determine your required memory.
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9. Click Forward.
= New VM
m Create a new virtual machine

Ready to begin installation of FMG-VM
0S: Generic 2.4.x kernel
Install: Import existing OS image
Memory: 8192 MB
CPUs: 2
Storage: 0.0 GB /root/Downloads/FGT_VM&4_XEN-v500-build0258-FORTI..
Customize configuration before install

= Advanced options

Specify shared device name - ‘ A

Bridge name: |xenbr0

Set a fixed MAC address
[00:16:3e:ec:63:72

Virt Type: xen (fullvirt) |«
Architecture: x86_64 -

&gancel| Back | #]] Finish |
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10. Select Customize configuration before install. This enables you to make hardware configuration changes before

the VM creation is started.

11. Expand the Advanced options section.
« By default, a new virtual machine includes one network adapter.

« Select Specify shared device name, and enter the name of the bridge interface on the Open Xen host.

« Optionally, set a fixed MAC address for the virtual network interface.
o Virt Type and Architecture are set by default and should not need to be changed.

12. Click Finish. The virtual machine hardware configuration window opens. It can be used to add hardware such as

network interfaces and disk drives.

n x Cancel
=
Basic Details
{:} Processor
Name: [FraG-vm
B= Memory
. i uuID: SeSdbfOe-7daf-6cbf-3335-c143779a42¢5
G Boot Options Status: = shutoff
[ pisk1 Description:
By nNIC ec:63:72
Input
Display VNC
Sound: default Hypervisor Details
2 Console Hypervisor: xen (fullvirt)
. Architecture: x86_64
Video 3
r: fusr/lib/.
Operating System
Hostname: unknown
Product name: unknown
¢» Applications
» Machine Settings
b Security
o= Add Hardware 3¢ cancel of Apply

13. Click Add Hardware to open the Add Hardware window, then click Storage.

14. Select Create a disk image on the computer's harddrive, and set the size to an appropriate size.

& ! ’, If you know your environment will expand in the future, or if you will be using ADOMs, it is
9 recommended to add hard disks larger than 500GB. This will allow your environment to
- be expanded as required while not taking up more space than is needed.
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The FortiManager VM allows for 12 virtual log disks to be added to a deployed instance.
ﬂ When adding additional hard disks use the following CLI command to extend the LVM
I logical volume:

execute lvm start
execute lvm extend <arg ..>

15. Select Network to add more network interfaces.
A new VM includes one network adapter by default. More can be added through the Add Hardware window.
FortiManager VM required four network adapters. You can configure network adapters to connect to a virtual
switch or to network adapters on the host computer.

16. Click Finish.

17. Click Begin Installation.
After the installation completes successfully, the VM will start and the console window will open. You can then
proceed with the initial configuration (Initial Configuration on page 47).
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The FortiManager VM can be deployed and configured using VMware vSphere Hypervisor™ (ESX/ESXi) and VMware
vSphere Client™,

VMware vSphere

Once you have downloaded the FMG VM64-v5-buildxxxx-FORTINET.out.ovf.zip file and extracted the
package contents to a folder on your management computer, you can deploy the OVF package to your VMware
environment.

Prior to deploying the FortiManager VM, ensure that the following are configured and functioning properly:

« VMware vSphere Hypervisor™ (ESX/ESXi) software must be installed on a server and updated to the latest patch
release prior to installing FortiManager VM. Go to http://www.vmware.com/products/vsphere-
hypervisor/index.html for installation details.

« VMware vSphere Client™ must be installed on the computer that you will be using for managing the FortiManager
VM.

The following topics are included in this section:

« Deploy the OVF file
« Configure hardware settings
o Power on the virtual machine

Deploy the OVF file

To deploy the OVF file template:

1. Launch the VMware vSphere client, enter the IP address or host name of your server, enter your user name and
password, then click Login. The vSphere client home page opens.
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& &

@ ]172.16.86.16

A Tasks

File Edit View Inventory Administration Plug-ins Help

G B (& rome > g mentory b Inventory

localhost.Jocaldomain VMware ESX), 5.1.0, 799733

What is a Host?

Basic Tasks
&' Deploy from VA Marketplace

&F Create a new virtual machine

[ e Summary | Virtual Machines | Resource Allocation | Performance | Configuration | Local Users & Groups | Events | Permissiol/J}

close tab []

Ahost is a computer that uses virtualization software, such
as ESX or ESXI, to run virtual machines. Hosts provide the
CPU and memory resources that virtual machines use and
give virtual machines access 1o storage and network

connectivity.

You can add a virtual machine to a host by creating a new N Host
one or by deploying a virtual appliance
Q

The easiest way to add a virtual machine is to deploy a
virtual appliance. A virtual appliance is a pre-built virtual

machine with an operating system and software already §
installed. A new virtual machine will need an operating -

system installed on it, such as Windows or Linux

Explore Further

| Learn about vSphere

Manage multiple hosts, eliminate downtime, load
balance your datacenter with vilotion, and more

-| Evaluate vSphere

roct
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2. Select File > Deploy OVF Template to launch the OVF Template wizard. The OVF Template Source page opens.
3. Click Browse, locate the OVF file on your computer, then click Next to continue. The OVF Template Details page

opens.

OVF Template Details
Verify OVF template detai.

Source
OVF Template Details
End User License Agrezment
Name and Location

Disk Format

Network Mapping

Ready to Complete

Product:

Download size:

Size on disk:

Description:

FortiManager-VM

30.1MB

Unknawn (tin provisioned)
80.0 GB (thick provisioned)

FortManager Virtusl Appiance by Fortinet Technologies Inc.

(http: [fowvvw. fortinet. com)

Help

<o oo

4. Verify the OVF template details. This page details the product name, download size, size on disk, and description.

Click Next to continue. The OVF Template End User License Agreement page opens.

5. Read the end user license agreement, then click Accept then Next to continue. The OVF Template Name and
Location page opens.

6. Enter a name for this OVF template. The name can contain up to 80 characters and it must be unique within the

inventory folder. Click Next to continue. The OVF Template Disk Format page opens.
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Disk Format.
In which format do you want to store the virtual disks?

Source Datastore: [Gatastore L
OVF Template Details
End User Licsnse AQTEEMENt b e (aB): 72

areement
Hame and Location

' Thick Provision Lazy Zeroed
 Thick Provision Eager Zeroed

 Thin Provision

oo <o | _nots

7. Select one of the following:

« Thick Provision Lazy Zeroed: Allocates the disk space statically (no other volumes can take the space), but
does not write zeros to the blocks until the first write takes place to that block during runtime (which includes a
full disk format).

« Thick Provision Eager Zeroed: Allocates the disk space statically (no other volumes can take the space), and
writes zeros to all the blocks.

« Thin Provision: Allocates the disk space only when a write occurs to a block, but the total volume size is
reported by the Virtual Machine File System (VMFS) to the OS. Other volumes can take the remaining space.
This allows you to float space between your servers, and expand your storage when your size monitoring
indicates there is a problem. Note that once a Thin Provisioned block is allocated, it remains in the volume
regardless of if you have deleted data, etc.

W0 If you know your environment will expand in the future, it is recommended to add hard
‘?' disks larger than the FortiManager VM base license requirement and utilize Thin
- Provision when setting the OVF Template disk format. This will allow your environment

to be expanded as required while not taking up more space in the SAN than is needed.

8. Click Next to continue. The OVF Template Network Mapping page opens.

Network Mapping
What networks should the deployed template use?
Source
Map the networks used in this OVF template to networks in your inventory
Source Networks DestinationNetworks
Network4 VM Network
Netwaork2 VM Network
Network 3 VM Network
Network 1 VM Network
Description:
The "Network 4" network
VWarning: Multiple source netwarks are mapped to the host network: VM Netwark
oo = el
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9. Map the networks used in this OVF template to networks in your inventory. Network 1 maps to port1 of the
FortiManager VM. You must set the destination network for this entry to access the device console. Click Next to
continue. The OVF Template Ready to Complete page opens.

10. Review the template configuration.

Ensure that Power on after deployment is not enabled. You might need to configure the FortiManager VM
hardware settings prior to powering on the VM.

11. Click Finish to deploy the OVF template. You will receive a Deployment Completed Successfully dialog box once
the FortiManager VM OVF template wizard has finished.

Configure hardware settings

Before powering on your FortiManager VM you must configure the virtual memory, virtual CPU, and virtual disk.

To configure the VM:

1. Inthe vSphere Client, right-click on the FortiManager VM in the left pane and select Edit Settings to open the
Virtual Machine Properties window.

2. Select Memory from the Hardware list, then adjust the Memory Size as required. See Minimum system
requirements on page 8 to determine your required memory.

@ FortiManager-VM - Virtual Machine Properties = =
Hardware | options | Resources | Virtual Machine Version: 7
Memory Configuration
I™ Show All Devices Add...
EHEN lemory Size:
Hardware Summary
128 GBI
B Memory B192MB
M crus 1 64 GBH
] videocard Video card
WMCI device Deprecated =
= ° Default recommer
@ sCsIcontroller 0 LSI LogicParallel 16681 A guest0s: 16G8.
S Hard disk1 Virtual Disk ol Mirimum recommended for this
& Hard disk2 virtual Disk <l guestOs: 32 MB.
BB Network adapter 1 VM Network 4GB
BB Network adapter2 WM Network
ED Network adapter 3 WM Network 2GRy
BB Network adapter4 WM Network 1 6B
512 MBH
256 MBH
126 MBH
64 MBH
32 MEH
16 MBH
6MBH
4mpU
oK Cancel

Y.

3. Select CPUs from the Hardware list, then adjust the Number of virtual sockets and Number of cores per socket
as required.
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@
Hardware | options | Resources |

I™ Show All Devices

FortiManager-VM - Virtual Machine Properties

Virtual Machine Version: 7

Add... Number of virtual sockets: 7 -

Mumber of cores per socket: PR

‘ Total number of cores: 4

Hardware Summary
M Memory 8182MB
i cpus z

[ videocard Video card
& WMCI device Deprecated
@ sCSlcontraller 0 LS1 LagicParallel
o Hard disk1 Virtual Disk
© Hard disk2 Virtual Disk
BB MNetwork adapter 1 VM Network
m Network adapter2 VM Network
BB Network adapter3 VM Network
BB Network adapter4 VM Netwark

/&y Changing the number of virtual CPUs after the guest
0 is installed might make your virtual machine
unstable.

The virtual CPU configuration spedified on this page
might violate the license of the guest OS.

|

oK Cancel

Y
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4. Select Hard disk 2, the log disk, from the Hardware list, and configure it as required. Hard disk 1 should not be

edited.
@

Hardware | Options | Resources |

FortiManager-VM - Virtual Machine Properties

Virtual Machine Version: 7

Disk File
I show Al Devices Add... Remove [[datastore ] FortManager-VM/FortManager-UM.vmdk
Hardviare Summary
| vemory 103M8 Disk Provisioning
@ crus 2 Type: Thin Provision
& videocard Video card Provisioned Size: znnngmssg GB v
& VMCLdeviee Deprecated Maximum Size (GB): 33.54
) 5CSlcontraller 0 LSI LagicParallel
© Hard disk1 Virtual Disk. | Virtual Device Node
= Hard disk2 Virtual Disk
BB Network adapter 1 VM Network [scst 0:0) Hard dsk 1 5
HD Network adapter2 VM Network
B9 Network adapter3 VM Network Mode
BB Network adapterd VM Netwark W) T

Independent disks are not affected by snapshots.

P
Changes are immediately and permanently written to
the disk,

-

Changes to this disk are discarded when you power
off or revert to the snapshot.

- cEN

oK Cancel

A

»
4

The FortiManager VM allows for 12 virtual log disks to be added to a deployed instance.

When adding additional hard disks use the following CLI command to extend the LVM
logical volume:

execute lvm start

execute lvm extend <arg

o>

5. Click OKto apply your changes.

Power on the virtual machine

You can now proceed to power on your FortiManager VM.
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« Select the FortiManager VM in the left pane and click Power on the virtual machine in the Getting Started tab.
« Select the VM in the left pane, then click Power On in the toolbar.
« Right-click the VM in the left pane, then select Power > Power On from the right-click menu.

Once the VM has started, proceed with the initial configuration. See Initial Configuration on page 47.
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FortiManager VM can be deployed on Microsoft Azure. Prior to deploying the VM, the following are required:
« Microsoft Azure subscription

« Virtual network
« Storage account

Deploy the virtual machine

This section shows the steps for deploying the FortiManager VM from your Microsoft Azure dashboard.

To deploy the VM:

Log in to your Azure account.
2. Click New in the option pane

3. Enter FortiManager in the search field on the New blade, then click Fortinet FortiManager for Azure in the results
list.

4. Inthe FortiManager VM blade, confirm that the deployment model is correct, then click Create.
5. Fill out the basic configuration settings:

VM Name Enter a name for the virtual appliance.
Administrative Username Enter the administrative name for the VM. It cannot be admin.
Password Enter then confirm the admin account password. The password must be

between 6 and 72 characters long, and contain characters from 3 of:
uppercase characters, lowercase characters, numbers, and special

characters.
Subscription Optionally, select a subscription from the drop-down list.
Resource Group Enter a current Resource Group for the VM, or create a new group.
Location Optionally, select a location from the drop-down list.

6. Click OKto proceed to the network and storage setting. Configure the following:
Virtual network Select a current virtual network, or create a new one.

Subnets Confirm or customize the subnet for the VM, including:
o Outside Subnet name
o Outside Subnet address prefix
« Inside Subnet name
o Inside Subnet address prefix
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Virtual machine size Select the size of the VM to provision. At least Standard A2, with 3.5GB of
RAM and two disks, must be selected.

Storage Account Select a storage account, or create a new account, to contain the disk drives
of the VM.

7. Click OK to proceed to the IP assignment setting. Configure the following:

Public IP address name Enter the public IP address name, or create a new one.

Domain name label Enter the DNS prefix to use for the public IP address.

Public IP Address Type Select if the IP address is static or dynamic.

Outside Address Confirm or customize the IP address of the outside interface of the VM.
Inside Address Confirm or customize the IP address of the inside interface of the VM.

8. Click OKto proceed to the Summary blade. If the VM fails validation, correct the errors and try again.
Click Download template to download the VM template as a JSON file.
9. Click OK to open the Create blade.
10. Read the terms of use and privacy policy, then click Create to create the VM.

11. To connect to the FortiManager VM GUI, open a web browser and use the public DNS address as the URL:
https://<public DNS address>

12. Log in with the configured administrative username and password to configure your FortiManager VM.
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FortiManager VM can be deployed on the AWS Elastic Compute Cloud (EC2). Prior to deploying the VM, the following
are required:

« Amazon EC2 account

The FortiManager VM can be deployed using either the AWS Marketplace 7-Click Launch option, or directly from the
EC2 console.

This chapter includes the following sections:

« AWS Marketplace 1-Click Launch
« AWSEC2 console

AWS Marketplace 1-Click Launch

This section shows the steps for deploying the FortiManager VM from the AWS Marketplace using the 7-Click Launch
option.

To deploy the VM from the AWS Marketplace:

1. Loginto AWS.
2. From the AWS Marketplace, find the Fortinet FortiManager-VM page by searching with the key word Fortinet, or
by selecting Security in the left pane.
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AWS deployment example

3. Onthe FortiManager VM page, click Continue.

\efawsmarketplace

Shop All Categories + Searc

Launch on EC2:
Fortinet FortiManager-VM

1-Click Launch
Review, modify, and launch

Manual Launch
With EC2 Console, APls or CLI

Click "Accept Terms & Launch with 1-Click" to launch this software
with the settings below
Once you accept the terms, you will have access to launch any version of this software in

any supported region. For future launches, you can return to this page or launch directly
from the EC2 consale, APIs or CLI.

b Version
v5.2.2, released 05/11/2015

» Region
US East (N. Virginia)

P EC2 Instance Type
m1.medium

b VPC Settings
Wil launch into: subnet-967dfac

b Security Group

Updated: Create new security group based on seller settings

b Key Pair

Please create a new key pair

Hello, & Harris. (Sign out)

Your Account | Help

m ¥ Your Software

Sell an AWS Marketplace

Price for your selections:

Bring Your Own License (BYOL)
Available for customers with current licenses
$0.09 / hour

m1.medium EC2 Instance usage fees
$0.05/ GB / month

EBS Magnetic Storage

$0.05 /1 million /O requests

EBS Magnetic Storage

Accept Terms & Launch with 1-Click

“ou wil be subscribed to this software and agree that your use of
this software is subject to the pricing terms and the seller's End User

License Agresment (EULA) 17

subject to the AWS Customer Agreement =

and your use of AWS services is.

w Cost Estimator

Bring Your Own License (BYOL)
Available for customers with current licenses
purchased via other channels

plus
$62.64 / month
mA1.medium EC2 Instance usage fees
Assumes 24 hour use over 30 days

4. Select a region and the instance type. Ensure that the instance type fits the size of your deployment and potential

future growth.
+ Region

US West (Oregon) v

« EC2 Instance Type

Memory 375 G
mlarge cru 2 EC2 Compute Units (1 virtual core
m.xlarge with 2 EC2 Compute Units)
hil.4xlarge Storage 1x410GB
m3xlarge Platiorm s4-pit
m3.2xlarge

Network Moderate

performance

APl Hame mi medium

5. Under Security Group, ensure that Create new based on seller settings is selected from the drop-down list.

The only open port that is required for the initial configuration of the VM is port 443, which will allow for an HTTPS
connections to the GUI. The remaining ports can also be opened to allow for all potential FortiManager

communication.
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w Security Group

Updated: Due to a change in other settings, security group settings is updated

A securtty group acts as a firewall that controls the traffic alowed to reach one or more instances.
Learn more about Securtty Groups.

You can create a new security group based on seller-recommended settings or choose one of your
existing groups.

Create new based on seller settings v

Description:
A new security group wil be gensrated by AWS Marketplace. ttis based on recommended sattings for
Fortinet Fortilanager-VI version v5.0.4 provided by Fortinet Inc..

Connection Method ~ Protocol PortRange  Source (IP or Group)

SSH tcp 22-22 Aywhere v |0
HTTP tep 80-80 Amywhers v |0
HTTPS tcp 443 - 443 Custom IP +|10.10.10.10
tep 514-514 Arywhere
tep 541-541 Anywhere v |0
tep 2032-2032 | Anywhere v |0
tep 3000-3000 | Anywhere |0
tep 5199-5199 | Anywhere v |0
tep 6020-6020 | Anywhere w |0
tep 6028-6028 | Amywhere w0
HTTP® tep 8080-8080 | Amywhere w |0
tep 8890-8890 | Amywhere w |0
DNS udp 53-53 Arywhere v |0
udp 6022 - 6022 Anywhere v |0
udp 6023-6023  [Anywhere |0
tcp 3383-8888 | Anywhere v |0

Warning
Rules with source of 0.0.0.0/0 allows all P addresses to access your instance. We recommend
limiting access to only known IP addresses,

41

Use the instructions provided under Key Pairto create a new key pair, or use an existing key pair if it is secure.

Click Accept Terms & Launch with 1-Click to deploy the instance and view the summary page.

Close the summary page, then, from the software subscriptions page, click Manage in AWS Console to view the

VM instance and the public DNS address.

Amazon Web Senices Home

v Swsmarketplace

O Hello, A Harris. (Sign out) Your Account | Help | Sell on AWS Marketplace

Shop All Categories v Search AWS Marketplace m »| Your Software
Your Account > See all AWS Account Activity &
Your Software Subscriptions (1) Enable ™ and create billing alerts 7 for AWS Marketplace charges

Products Instances Actions

Fortinet Fortillanager-Vil — @ 1active e e

Contact vendor iHc11calb @ running Manage in AWS Console ™™ Access Software T30

Write a review Version v5.4.0 Launch more software

The public DNS address is used to connect to and configure the FortiManager VM via the GUI.
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—
Events
Tags Q, search: i-icl1ca0b | Addfilter
Reports
Limits @ MName - InstancelD - | Instance Type~ Availability Zone~ Instance Stater Status Checks
= [] ifcticalb m1.medium us-west-2a @ wnning @ 212 checks passed
Instances
Spot Requests
Reserved Instances
AMls
Bundle Tasks
Volumes
Snapshots
<
Sesurity Groups Instance: | i-fc11calb  Public DNS: ec2-52-24-115-179.us-west-2.compute. com
Elastic IPs
Description | Status Checks | Monitoring | Tags | Usage Instructions:
Placement Groups
Instance ID  i-fc11ca0b Public DNS
Load Balancers
Key Pairs
Instance state  running Public IP
Network Interfaces
Instance type  m1.medium Elastic IP
= Private DNS  ip-172-31-29-75.us- Availability zone
Launch Gonfigurations west-2.compute intemal
Auto Scaling Groups Private IPs ~ 172.31.29.75 Security groups
‘Secondary private IPs ‘Scheduled events

VPG ID

® Feedback @ English

9. To connect to the FortiManager VM GUI, open a web browser and use the public DNS address as the URL:

Vpe-2667e143

https://<public DNS address>

10. Log in with default username admin and the instance ID as the password to configure your FortiManager VM.

AMIID

AMHarris v Oregon~  Support

o % 0
2] 1t010f1
Alarm Status | Public DNS | Publ

None g ec25224-115-179usw.. 522

_N-N=l

€C2-52-29-115-179.us-
west-9_compute amazenaws. com
5229115179

us-west-2a

Fortinet FortiManager-VM-v5-2-2-
AutogenByAWSMP- . view rules

No scheduled events

FortiManager VM64-AWS build0206

AMI Release-c9da2a2s-5ef5-444b-
bQ1b-3cBdce2araet-ami-206¢3d40.2
(ami-900090a0) v

Privacy Policy  Terms of Use
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A\,

first 10 characters are used as the default password.

‘Q' In FortiManager VM 5.4.1 and earlier, if the instance ID is a long ID (19 characters), only the

AWS EC2 console

This section shows the steps for deploying the FortiManager VM directly from the EC2 console.
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To deploy the VM from the EC2 console:

1. Loginto AWS and go to your EC2 dashboard.

EC2 Dashboard
Events 4
Tags

Reports

Limits

Instances
Spot Requests

Reserved Instances

AMIs
Bundle Tasks

Volumes

Snapshots

Security Groups
Elastic IPs
Placement Groups
Load Balancers
Key Pairs

Network Interfaces

Launch Configurations
Auto Scaling Groups

® Feedback @ English

Resources

You are using the following Amazon EC2 resources in the US West (Oregon) region:

1 Running Instances
2 Volumes
1 Key Pairs
0 Placement Groups

Create Instance

To start using Amazon EC2 you will want to launch a virtual server, known as an Amazon EC2 instance.

N

2: Your instances will launch in the

Service Health
Service Status:

US West (Oregon):
This service is operating normally

Auvailability Zone Status:

us-west-2a:

Availability zone is operating normally

us-west-2b:

Availability zone is operating normally

us-west-2:

Availability zone is operating normally

Service Health Dashboard

US West (Oregon) region

0 Elastic IPs
0 Snapshots
0 Load Balancers
2 Security Groups

' Scheduled Events

US West (Oregon):

No events

Account Attributes [

Supported Platforms
VPC

Default VPG
vpe-2662¢122

Additional Information

Getting Started Guide
Documentation

All EC2 Resources
Forums

Pricing

Contact Us

AWS Markstplace
Find free software trial products in the

AWS Marketplace from the EC2 Launch
Wizard.

2. Click Launch Instance to choose an Amazon Machine Image (AMI).
3. Select the AWS Marketplace category, then search for Fortinet.

1.Choose AMI

2. Choose Instanc

3. Config 4 AddStorage 5. Tag Instan

Step 1: Choose an Amazon Machine Image (AMI)
An AMI is a template that contains the software configuration (operating system, application server, and applications) required to launch your instance. You can select an AMI provided by AWS, our A
user community, or the AWS Marketplace; or you can select one of your own AMis.

Quick Start
My AMis
AWS Marketplace

Community AMIs

¥ Categories
All Categories
Software Infrastructure: (6)
¥ Operating System
Clear Filter
¥ Al Linwd/Unix
CIOther Linux (6)

¥ Software Pricing Plans
O Hourly @)
ClAnnual (2)
[ Bring Your Own License
@

~ Region

Current Region (6)

CIAll Regions (6)

® Feedback @ English

- Fortinet X

TINET.  Fortinet FortiManager-VM
ek ek (0} ¥6.4.4 | Sold by Fortinst Inc.
Bring Your Own Liconss + AWS Usage fess

Linux/Unix, Other v6.4.4 | 64-bit Amazon Maching Imaga (AM) | Updatsd: 11110/16

6. Configure Security Group 7. Review

Cancel and Exit

1to 6 of 6 Products

ForiiManager Security Management appliances allow you to centrally manage any number of Fortinet Network Security

devices, from several to thousands, including FortiGate,

More info

Fortinet FortiAnalyzer-VM
ok (1)| v5.4.4 | Sold by Fortinst Inc.
Bring Your Own Licanso - AWS usage foas

Linux/Unix, Other v5.4.4 | 64-bit Amazon Machine Image (AM] | Updated: 11/10/16

FortiAnalyzer Network Security Logging, Analysis, and Reporting Appliances securely aggregate log data from Fortinet

Security Appliances. A comprehensive suite of easily ..

More info

Fortinet FortiGate-VM

i (21| v5.0.9| Sold by Fortinat, Inc.
‘Starting from $0.30/hr or from $1,992/yr (up to 24% savings) for software + AWS usage fess
Linux/Unix, Other v5.0.9 | 64-bit Amazon Machine Imags (AMI) | Updated: 10/23/14

Fortinet FortiGate-VM firewall technology delivers complete content and network protection by combining stateful inspection

with a Gomprehensive suite of powerful security ...

More info

FortiManager VM Install Guide

43

Fortinet Technologies Inc.



AWS deployment example 44

4. Select the FortiManager VM, and then choose the instance type that matches your license.

1.ChooseAMI  2.Chooseinstance Type 3. Configure Instance 4. Add Storage 6. TagInstance 6. Configure Security Group 7. Review.

Step 2: Choose an Instance Type

Amazon EC2 provides a wide selection of instance types optimized to fit different use cases. Instances are virtual servers that can run applications. They have varying combinations of GPU, A
memory, storage, and networking capacity, and give you the flexibility to choose the appropriate mix of resources for your applications. Learn more about instance types and how they can meet
your computing nesds.

Fiterby: = Generalpupose v | All generations v Show/Hide Columns

Currently selected: m1.medium (2 ECUs, 1 vGPUs, Intel Xeon Family, 3.7 GiB memory, 1 x 410 GiB Storage Gapacity)

Note: The vendor recommends using a m1.medium instance (or larger) for the best experience with this product.

Family - Type - voPUs (i) ~  Memory(GiB) ~ Instance Storage (GB) (i)~ EBSO"“"'Z?" Avakable | yetwork Pesformance (1) +
2 neral purpose 1 1 EBS only - Low to Moderate
[ al purpose 1 2 EBS only - Low to Moderate
[ neral purpose 2 4 EBS only - Low to Moderate
[ General purpose m3.medium 1 375 14 (SSD) - Moderate
-] General purpose m3.large 2 75 1x 32 (SSD) - Moderate
General purpose 4 15 2x 40 (SSD) Yes High
General purpose ] 30 2% 80 (SSD) Yes High
] General purpose m1.small 1 1.7 1x 160 - Low
General purpose mi.medium 1 37 1x410 - Moderate
General purpose m.large 2 75 2x420 Yes Moderate

v

et [ P PP —

® Feedback (@ English

5. Click Next: Configure Instance Details to configure the instance details, including the public subnet and network
interfaces.

1.Chooss AMI 2 ChooseInstance Type 3. ConfigureInstance 4. Add Storage 5. Tag Instance 6. Configure Security Group 7. Review

Step 3: Configure Instance Details
Configure the instance to suit your requirements. You can launch multiple instances from the same AMI, request Spot Instances to take advantage of the lower pricing, assign an access A
management role to the instance, and more.

Number of instances (1 1
Purchasing option (i Req
Network  ( Vpc-2667e143 (172.31.0.0/16) (default) v| C Create new VPG
Subnet (i subnet-d579c5a2(172.31.32.0/20) | Default in us-we v Create new subnet

4091 IP Addresses available

Auto-assign Public IP (] Use subnet setting (Enable) v
1AM role (i None v| C Create new 1AM role
Shutdown behavior (7 Stop v

Enable termination protection

[ Protect against accidental termination

Monitoring (i [ Enable CloudWatch detailed monitoring
Additional charges apply.
Tenancy (i Shared tenancy (multi-tenant hardware) v

Additional charges will apply for dedicated tenancy.

~ Network interfaces
Device  Network Interface Subnet Primary IP Secondary IP addresses

etho New network interface v| | subnet-d579¢c5a: Add 1P

v

Cancel Previous Review and Launch Next: Add Storage

‘® Feedback @ English

A network interface must be manually created so that you can upload your license file. Up to two interfaces can be
attached to the instance.
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6. Click Next: Add Storage to configure the instance's storage based on your requirements.

A Harris v
1. Choose AMI

Support v
2.Choose Instance Type 3. Configure Instance~ 4.Add Storage 5. TagInstance 6. Configure Securty Group 7. Review
Step 4: Add Storage
Your instance will be launched with the following storage device settings. You can attach additional EBS volumes and instance store volumes to your instance, or
edit the settings of the root volume. You can also attach additional EBS volumes after launching an instance, but not instance store volumes. Learn more about
storage options in Amazon EC2.
Type (i Device (i Snapshot (i Size (GiB) (i)  Volume Type (i 10PS (i)  Delete on Termination (i) | Encrypted (i
Root /devisda snap-ac081790 1 Magnetic v NA Not Encrypted
EBS v |ldevisdb v Search (case-insensitiv| |10 Magnetic v A NotEncrypted €3
Add New Volume
Q General Purpose (SSD) volumes provide the ability to burst to 3000 IOPS per volume, independent of volume size, to meet the performance needs
of most applications and also deliver a consistent baseline of 3 IOPS/GiB. Set my root volume to General Purpose (SSD).
Free tier eligible customers can get up to 30 GB of EBS General Purpose (SSD) or Magnetic storage. Learn more about free usage tier eligibility
and usage restrictions.
e e ——
® Feedback @ English

Terms of Use

7. Click Next: Tag Instance to create a tag. A tag consists of a key-value pair. It is useful to create tags to quickly
reference instance items in your deployment. Up to 10 tags can be added.

AMarris v Oregonv  Support v
1. Choose AMI 2. Choose Instance Type 3. Configure Instance 4._Add Storage 5. Tag Instance 6. Configure Security Group 7. Review

Step 5: Tag Instance

Atag consists of a case-sensitive key-value pair. For example, you could define a tag with key = Name and value = Webserver. Learn more about tagging your Amazon EG2 resources.
Key (127 characters maximum) Value (255 characters maximum)
Name ForiManager VIV [x]
Public IP 10003 [x]
Private IP 10013 [x]
Create Tag (Up to 10 tags maximumm)

et [ P T ——

‘® Feedback (@ English

Privacy Policy  Terms of Use

8. Click Next: Configure Security Group, then either create a new security group, or select an existing security group.
The default provided security group is based on recommended settings the FortiManager VM.
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1.

1. ChooseAMI 2 Choose Instance Type 3. Configure Instance 4. Add Storage 5. Tag Instance 6. Configure Security Group

Step 6: Configure Security Group

A Harris v

7. Review

Oregon v

Support ¥

A security group is a set of firewall rules that control the traffic for your instance. On this page, you can add rules to allow specific traffic to reach your instance. For example, if you want to set up
a web server and allow Intemet traffic to reach your instance, add rules that allow unrestricted access to the HTTP and HTTPS ports. You can create a new security group or select from an

existing one below. Learn more about Amazon EC2 security groups.
Assign a security group:  ® Greate a new security group

O Select an existing security group

Security group name: | FortinetF M5 g 1
Description: | This security group was generated by AWS Marketplace and is based on recommen

Type (i Protocol (i Port Range (i

SSH v TCP 22

HTTP v TCP 30

HTTPS v TCP 443

Custom TCP Rule v TCP 514

Custom TCP Rule v TCP 541

Custom TCP Rule v TCP 2032

Custom TCP Rule v TCP 3000

Custom TCP Rule v TCP 5199

Custom TCP Rule v TCP 6020

Custom TCP Rule v TCP 6028

Custom TCP Rule v TCP 3080

Custom TCP Rule v TCP 3330

DNS (UDP) v UDP 53

Custom UDP Rule v UDP 6022

Custom UDP Rule v UDP 6023

Custom TCP Rule v TCP 3585

Add Rule

Source (i

Anywhere v| 00000
Anywhere v| 0000/0
Anywhere v| 00000
Anywhere v| 0000/0
Anywhere v| 00000
Anywhere v| 0000/0
Anywhere v| 0000/0
Anywhere v| 00000
Anywhere v| 0000/0
Anywhere v| 00000
Anywhere v| 0000/0
Anywhere v| 0000/0
Anywhere v| 00000
Anywhere v| 0000/0
Anywhere v| 00000
Anywhere v| 0000/0

QOO OOOO0000000G

A Voo

Rules with source of 0.0.0.0/0 allow all IP addresses to access your instance. We recommend setting security group rules to allow access from known IP addresses only.

‘® Feedback @ English

Cancel Previous Review and Launch

Privacy Policy

Terms of Use.

"

v
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Click Review and Launch. If necessary, decide which boot volume to boot the instance from.
Review the instance, including the AMI details, instance type, security groups, instance details, storage, and tags.

Edit the configuration as needed.

Click Launch, select Proceed without a key pair from the drop-down list, then select the checkbox acknowledging
that you already have the username and password for the AMI.

Select an existing key pair or create a new key pair X

A key pair consists of a public key that AWS stores, and a private key file that you store. Together, they
allow you to connect to your instance securely. For Windows AM|ls, the private key file is required to
obtain the password used to log into your instance. For Linux AMIs, the private key file allows you to
securely S8H into your instance.

Note: The selected key pair will be added to the set of keys authorized for this instance. Learn more
about removing existing key pairs from a public AMI.

Proceed without @ key pair v

[4]1 acknowledge that | will not be able to connect to this instance unless | already know the
e} ly
password built into this AMI.

12. Click Launch Instances to launch the new FortiManager VM instance.

13. To connect to the FortiManager VM GUI, open a web browser and use the public DNS address as the URL:

https://<public DNS address>

14. Log in with default username admin and the instance ID as the password to configure your FortiManager VM.

\,

first 10 characters are used as the default password.

‘9' In FortiManager VM 5.4.1 and earlier, if the instance ID is a long ID (19 characters), only the
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Initial Configuration

Before you can connect to the FortiManager VM you must configure basic configuration via the CLI console. Once
configured, you can connect to the FortiManager VM GUI and upload the FortiManager VM license file that you
downloaded from the Customer Service & Support portal.

The following topics are included in this section:

o GUI access
o Upload the license file
« Configure your FortiManager VM

GUI access
Ay
‘Q' FortiManager VM AWS and Azure instances do not require any special configuration to
|| enable GUI access. The GUI can be accessed with the public DNS.

Enable GUI access

To enable GUI access to the FortiManager VM you must configure the IP address and network mask of the appropriate
port on the FortiManager VM. The following instructions use port 1.

ﬂ The appropriate port can be determined by matching the MAC address of the network
l adapter and the HWaddr provided by the CLI command diagnose fmnetwork

interface list.

To configure the port1 IP address and netmask:

1. Inyour hypervisor manager, start the FortiManager VM and access the console window. You might need to press
Enterto see the login prompt.
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File Edit View Inventory Administration Plug-ins Help
€] €) Home b g Tnventory b [l Inventory
0Ny &8GR e RS E

EXTLINUX 3.53 2887-11-17 EBIOS Copyright (C) 1994-2887 H. Peter Anvin
Loading vmlinuz
Loading /rootfs

@ Fortigate-VM64-178
(G Fortigate-M64-179
) Fortigate-VMs4-656

{3 [FortiManager-Vi-01
& window8 eat

Formatting LUM disk (extd)... done
Creating swapfile...0K

Initialize file systems...
New version: v5.8-build@151 138328 (GA Patch 2)

FMG-UMB4 login: GUI started.

FMG-UMB4d login: admin

Password :
FMG-UMB4 # _

A Tasks rect

2. At the FortiManager VM login prompt, enter the username admin, then press Enter. By default, there is no
password.

3. Using CLI commands, configure the port1 IP address and netmask.
For example:

config system interface
edit portl
set ip <IP address> <netmask>
end

ﬂ The port management interface should match the first network adapter and virtual switch
I that you have configured in the hypervisor virtual machine settings.

4. To configure the default gateway, enter the following commands:
config system route
edit 1
set device portl
set gateway <gateway ipv4 address>
end

The Customer Service & Support portal does not currently support IPv6 for FortiManager
VM license validation. You must specify an IPv4 address in both the support portal and
the port management interface.

Connect to the GUI

Once you have configured a port's IP address and network mask, launch a web browser and enter the IP address you
configured for the port management interface. At the login page, enter the user name admin and no password, then
select Login.

The GUI will open with an Evaluation License dialog box.
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Upload the license file

FortiManager VM includes a free, full featured 15 day trial.

Before using the FortiManager VM you must enter the license file that you downloaded from the Customer Service &
Support portal upon registration.

To upload the license via the CLI:

1. Open the license file in a text editor and copy the VM license string.

2. In aFortiManager VM console window, enter the following:
execute add-vm-license <"vm license string">

See the FortiManager CLI Reference, available from the Fortinet Document Library, for more details on using this
command.

To upload the license file via the GUI:

1. Inthe Evaluation License dialog box, select Enter License.
Optionally, you can also select Upload License in the License Information dashboard widget.

2. Inthe license upload page, click Browse, locate the VM license file (.11 c) on your computer, then click OK to
upload the license file.

A reboot message will be shown, then the FortiManager VM system will reboot and load the license file.
3. Refresh your browser and log back into the FortiManager VM with username admin and no password.
The VM registration status appears as valid in the License Information widget once the license has been validated.

NP As a part of the license validation process FortiManager VM compares its IP address with
‘?' the IP information in the license file. If a new license has been imported or the
- FortiManager's |IP address has been changed, the FortiManager VM must be rebooted in

order for the system to validate the change and operate with a valid license.

If the IP address in the license file and the IP address configured in the FortiManager VM do not match, you will
receive an error message when you log back into the VM.

If this occurs, you will need to change the IP address in the Customer Service & Support portal to match the
management IP and re-download the license file. To change the management IP address, see To edit the
FortiManager VM IP address: on page 10

After an invalid license file has been loaded onto the FortiManager VM, the GUI will be
locked until a valid license file is uploaded. A new license file can be uploaded via the

CLI.

Configure your FortiManager VM

Once the FortiManager VM license has been validated, you can configure your device.
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drive space is less than the licensed VM storage volume, warning messages will be shown in

\ If the amount of memory or number of CPUs are too small for the VM, or if the allocated hard
I the GUI in the System Resources widget on the dashboard and in the Notification list.

For more information on configuring your FortiManager VM, see the FortiManager Administration Guide available in
the Fortinet Document Library.
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